
Introduction
Antibiotic resistance is a process by which bacteria 
become resistant to different antibiotics, rendering the 
intended antibiotic unable to treat the infection caused by 
the resistant bacteria. This phenomenon can lead to many 
medical and economic problems. Therefore, antibiotic 
resistance can create many complications for people, the 
medical system, and governments (1).

Bacteria can develop resistance to antibiotics through 

various mechanisms. One method involves bacterial 
cells preventing the entry of antibiotics, thereby stopping 
these drugs from reaching their target within the bacteria. 
Another strategy uses efflux pumps to expel antibiotic 
molecules out of the cells, thus reducing the intracellular 
concentration of the drug. Additionally, some cells modify 
the chemical structure of antibiotics to disrupt their 
activity. Finally, bacteria can alter the molecular structure 
of the antibiotic’s target molecules, such as ribosomes, 
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Abstract
Background: Due to the increasing demand for new antibiotics, extensive research is being 
conducted on various compounds, particularly plant-based compounds. Among them, plant 
essential oils (EOs) have been investigated for their antibacterial properties in numerous studies. 
Accordingly, the inhibitory and bactericidal effects of Cuminum cyminum and Foeniculum 
vulgare EOs on two bacterial species, Escherichia coli and Listeria monocytogenes, were 
examined in this study.
Methods: The compounds present in these extracts were evaluated using gas chromatography-
mass spectrometry analysis. Subsequently, molecular docking methods were employed to depict 
the interactions of these compounds with the active site of the beta-lactamase enzyme of these 
bacteria in three-dimensional illustrations.
Results: Laboratory methods such as disk diffusion agar, minimum inhibitory concentration 
(MIC), and minimum bactericidal concentration (MBC) revealed that although the bactericidal 
properties of these extracts were weak, they exhibited strong growth inhibitory properties, 
particularly the effect of F. vulgare EO on L. monocytogenes (MIC = 1/104). Additionally, with 
the presence of p-cumin aldehyde at 33.7% in the cumin extract and trans-anethole at 46.5% in 
the fennel extract, molecular docking analyses showed that the binding ability and antibacterial 
properties of the cumin extract against E. coli by two hydrogen bonds and fennel extract against 
L. monocytogenes by two hydrogen bonds were more pronounced considering the level of 
binding energies.
Conclusion: Although the extracts represented weak bactericidal properties, their strong 
inhibitory effects on bacterial growth, especially with F. vulgare EO on L. monocytogenes, 
are notable. Moreover, the active compounds, such as p-cumin aldehyde and trans-anethole, 
demonstrated significant potential as alternative antibacterial agents.
Keywords: Antibiotic resistance, Essential oils, Antibiotics, Docking
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to prevent the antibiotic from binding and functioning 
effectively (2,3).

Nowadays, the level of antibiotic resistance is 
considerably increasing due to the incorrect and excessive 
usage of antibiotics, causing concerns within the medical 
community. Thus, to combat resistant bacteria, there is a 
need to discover or synthesize new antibiotics. This requires 
various research efforts to identify these compounds. They 
can be extracted from a multitude of living organisms, 
including animals, microorganisms, and plants (4).

Several studies have been conducted on the antibacterial 
effects of compounds extracted from different plant species, 
resulting in the discovery of many effective substances (5-
7). Among them, research has also been performed on 
green cumin (Cuminum cyminum) and fennel (Foeniculum 
vulgare), examining their health-related impacts, which 
make them suitable candidates for research on the 
antibacterial compounds in their essential oils (EOs) (8).

C. cyminum, commonly referred to as cumin or ‘zeera’ 
in Persian, is a member of the Apiaceae family. This herb 
is noted for its aromatic qualities and is utilized both as 
a spice and a natural preservative in foods (9). Cumin is 
a staple for adding flavor to various dishes, salads, and 
dairy products across numerous cultures (10). The EO 
derived from C. cyminum and its primary constituents 
are recognized as safe, natural alternatives to artificial 
preservatives and additives in the food sector (11). 
Furthermore, studies have highlighted the plant’s diverse 
pharmacological benefits, including potent antioxidant 
(12,13), antibacterial (14), antifungal (15), and pain-
relieving properties (7,12).

Fennel, scientifically named F. vulgare, is highly regarded 
as a therapeutic herb in Morocco and is a member of 
the Apiaceae family. This plant thrives in various global 
regions and serves multiple purposes (16). The fruits and 
extracted EOs from mature fennel are incorporated into 
cosmetic and medicinal products. Further, they enhance 
the taste of food items, including liqueurs, bread, and 
cheese (17,18). The leaves and seeds are integral to diverse 
cooking practices (19). Notably, fennel is used to address 
health issues such as cardiovascular problems, allergies, 
kidney stones, menopausal symptoms, nausea, and 
obesity. Moreover, it is known to boost appetite and aid 
in digestion (20-22). In this study, the antibacterial effects 
of green cumin and fennel EOs on the bacterial species 
Escherichia coli and Listeria monocytogenes were examined 
using various antibacterial susceptibility laboratory 
techniques. Subsequently, the active substances of these 
extracts were investigated using gas chromatography-
mass spectrometry (GC-MS) test.

Materials and Methods
In Vitro Studies
Essential Oil Extraction Method
After preparing the desired plants in dried form, the 
plant samples were powdered using a milling device and 
prepared for EO extraction. A Clevenger apparatus was 

utilized for the extraction process. In this method, 40 g of 
the dried plant powder was mixed in 1 L of distilled water 
within the flask and set on an electric heater for 4 hours 
to boil. Subsequently, the essence was separated from the 
plant distillate using the discharge valve.

Bacteria Species 
In this study, the bacterial strains L. monocytogenes 
IBRC-M 10671 and E. coli ATCC 25922 were utilized, 
and these strains were purchased from the Rasa Gene 
Company, Shiraz, Iran.

Investigation of Growth Inhibition by the Disc Diffusion 
Method
A 2000-ppm concentration of EOs was used in all the 
following tests. For the disc diffusion method, a cotton 
swab was utilized to apply the bacterial suspension onto 
a Petri dish containing Mueller-Hinton agar (MHA) 
medium. The dish was then incubated at 37 °C for 24 
hours. Next, 50 µL of each essence was applied onto 6-mm 
paper discs using a sampler. Moreover, a disc containing 
dimethyl sulfoxide (DMSO) was considered the control 
group. The 0.5 McFarland concentration equal to 1 × 108 
CFU/mL of the microbial samples, which were in the 
logarithmic growth phase, was prepared and cultured on 
the culture media. Then, the paper discs containing the 
EO were placed at specified distances, and after 24 hours 
of incubation at 35-37 degrees Celsius, the diameter of 
the inhibition zone was measured using calipers based 
on the Kirby Bauer method (23). Finally, the results were 
analyzed using Tukey’s analysis of variance statistical test 
with IBM SPSS software, version 25.

Determination of Minimum Inhibitory Concentration
The minimum inhibitory concentration (MIC) of the 
EO was identified as the concentration at which bacterial 
growth is inhibited. The broth microdilution method was 
used for this purpose. In 96-well plates, serial dilutions 
of EOs ranging from 1/101 to 1/110 v/v were prepared 
using Mueller-Hinton broth (MHB). In addition, 2% of 
the DMSO was added to each well. After being diluted 
in the MHB, bacterial suspensions with a turbidity 
of 0.5 McFarland were made and added to each well. 
Furthermore, a mixture of MHB and DMSO devoid of 
EOs was employed as growth controls. The plates were 
incubated under aerobic conditions for 18–24 hours at 37 
°C. Following the incubation period, the bacterial growth 
was evaluated visually.

Determination of Minimum Bactericidal Concentration
The MBC test is recognized as the lowest concentration 
of the antimicrobial agent that kills 99.9% of the bacterial 
cells. To determine the MBC, 10 µL of the samples were 
taken using a pipette from all the wells that had been 
evaluated in the MIC test. Subsequently, each sample was 
cultured on a sterile MHA medium. The culture plates 
were incubated for 24 hours at 37 °C. The lowest dilution 
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of the essences that had resulted in bacterial death was 
identified by the absence of bacterial colonies on the plate 
and considered the MBC of that essence. 

Chemical Composition Analysis of Essential Oils Using Gas 
Chromatography–Mass Spectrometry 
The chromatographic analysis of EOs was performed 
using a Perkin Elmer gas chromatograph. A column with 
a length of 30 meters, an internal diameter of 0.25 mm, 
and a film thickness of 0.25 µm was used in this method. 
Furthermore, the fragmentation process was conducted 
by ionization energy at 70 eV. The temperature program 
was initially set at 50 °C for 2 minutes, then increased 
by 8 °C per minute for 18 minutes until reaching 290 
°C. Helium was utilized as the carrier gas at a flow rate 
of 1 mL/min. The sample size was 1 µL of the EO, which 
was diluted in hexane. The mass spectra (GC-MS) of the 
EOs were analyzed by comparing them with the mass 
spectra in the Wiley NBS75K.L and NIST/EPA/NIH 
libraries (2002 edition, National Institute of Standards and 
Technology, USA). This method is especially employed 
for identifying various compounds in EOs. The mass 
spectra obtained from this analysis were compared with 
those in the libraries, and the compounds were identified 
accordingly (20).

In Silico Studies
Three-Dimensional Structure and Molecular Docking
In this study, the H Dock server was utilized for molecular 
docking; the ligand and protein files were uploaded on the 
site, and the docking results were observed. The research 
focused on compounds with medicinal properties. The 
structures of the compounds were obtained from the 
PubChem database (http://pubchem.ncbi.nlm.nih.gov). 
Moreover, the appropriate crystal structure of the beta-
lactamase enzyme containing the central catalytic domain 
was selected and downloaded from the RCSB Protein 
Data Bank (PDB; https://www.rcsb.org/pdb). The enzyme 
codes for E. coli and L. monocytogenes were 1JWZ and 
5ZQB, respectively.

The enzyme structure downloaded from the PDB 
site was opened with Discovery software. The panel 
was opened, and HETATM structures were removed to 
exclude non-protein parts. Additionally, except for the 
main chain, other chains were removed, leaving only the 
main chain and protein parts. The file was then saved in 
the PDB format with the extension pro1.pdb.

Enzyme File Preparation
The file containing the desired sample was created on the 
desktop, containing the enzyme downloaded from the 
PDB site, the enzyme file prepared with Discovery, and 
the compounds prepared with HyperChem.

Enzyme Preparation With Chimera
The option File → Open was selected, and the file 
containing the enzyme downloaded from the PDB site, the 

enzyme file prepared with Discovery, and the compounds 
prepared with HyperChem was opened. The enzyme file 
prepared with Discovery, named pro.pdb, was selected. 
Several options were used, including the Select → Residue 
standard and without it, and Tool → Structure Editing → 
Dock Prep. In this section, all hypotheses were accepted, 
and default settings were chosen throughout. Next, the 
options Tool → Structure Editing → Minimize Structure → 
Minimize were utilized, and the process was allowed to 
run until fully optimized. Finally, the file was saved with 
the pdb format using File → Save.

Analysis of Docking Results
The ten models with the most negative energy from the 
docking results were downloaded. The first model, with 
the most negative energy, was selected and analyzed using 
Discovery software. The panel was opened from the top 
left corner, and the interactions of the compounds with 
the active site of the beta-lactamase enzyme underwent 
examination. Several steps were performed, including 
Ligand → Structure → H-bond Monitor, where all hydrogen 
bonds formed in the enzyme’s active site were shown. The 
possible outcomes include the formation of no bonds or 
the formation of several bonds. The compound’s effect on 
the enzyme under study can be determined based on the 
number of formed bonds.

The results, including the most favored regions, 
disallowed regions, ligand binding energies, and types 
of ligand-protein interactions (e.g., hydrogen bonds, 
hydrophobic interactions, π interactions, interactions 
with copper ions in the enzyme’s active site, and other 
interactions), were observed and analyzed after performing 
the docking procedure. The Discovery software and two 
servers, HDOCK and PDBsum Generate, were employed 
to obtain this information.

Results
In Vitro Studies Results
The Inhibition Zone Size in the Disk Diffusion Method
Based on the examination of the inhibition zone diameter, 
cumin EO exhibited better inhibitory performance against 
the bacterial species of interest, L. monocytogenes and E. 
coli. In contrast, the inhibitory property of fennel EO was 
slightly lower than that of the cumin EO. Table 1 provides 
data on the extent of the inhibition zone, showing results 
from three repetitions for each EO. 

Minimum Inhibitory Concentration and Minimum 
Bactericidal Concentration
The MIC and MBC test results indicated that the cumin 
EO had greater antibacterial effects on the studied bacteria, 
where cumin EO inhibited L. monocytogenes at a dilution 
of 1/400 and fennel at 1/100, with the MBC observed at a 
dilution of 10 for both EOs, as evidenced by the absence 
of bacterial colonies on MHA. Additionally, it showed 
inhibitory effects on E. coli at a dilution of 1/10 and fennel 
at a dilution of 1/200. Table 2 and Table 3 present the MIC 

http://pubchem.ncbi.nlm.nih.gov
https://www.rcsb.org/pdb
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and MBC results of EOs, respectively.

Chemical Composition of Cuminum cyminum and 
Foeniculum vulgare Essential Oils
According to the GC-MS analysis results, different 
compounds were identified in each EO. Almost 92.55% 
of the chemicals and 99.36% of the compounds were 
identified in the cumin and fennel EOs, respectively. The 
main compounds in these EOs were p-cumin aldehyde 
and trans-anethole, with 33.7% and 46.5%, respectively. 
All compounds and values are listed in Tables 4 and 5.

Results of in Silico Studies
Molecular Docking of the Active Compounds of Essential Oils
The p-cumin aldehyde, the main compound in the C. 
cyminum EO based on GC-MS analysis, is shown to 
dock in the active site of the beta-lactamase enzyme in L. 
monocytogenes, forming a hydrogen bond with the amino 
acid TRP79, with a binding energy of -82.72 kcal/mol 
(Figure 1).

Additionally, the interaction of trans-anethole, the main 
chemical compound in fennel, with the enzyme beta-
lactamase of L. monocytogenes underwent evaluation. 
This molecule, when positioned in the enzyme’s active 
site, participates in hydrogen bonding with the amino 
acids GLU190 and ARG108, with a binding energy of 
-78.71 kcal/mol. 

Therefore, the docking results regarding the interactions 
of molecules and L. monocytogenes beta-lactamase 
indicated that the compounds trans-anethole and p-cumin 

aldehyde bind to the active site of the enzyme, possibly 
inhibiting the enzyme. The compound p-cumin aldehyde 
forms one hydrogen bond with the beta-lactamase enzyme 
in the active site, while trans-anethole forms two hydrogen 
bonds with the beta-lactamase enzyme in the active site. 
Among these compounds, trans-anethole represents a 
better inhibitory effect on beta-lactamase (Figure 2).

Considering the structural differences between the 
beta-lactamase enzymes of E. coli and L. monocytogenes, 
all of the above-mentioned steps were repeated for E. coli. 
It was demonstrated that p-cumin aldehyde can bind to 
amino acids LYS73 and SER70 in the enzyme’s active site 
by hydrogen bonding, with a binding energy of -79.12 
kcal/mol (Figure 3).

The analysis of trans-anethole revealed that this 
compound is positioned in the enzyme’s active site and 
participates in hydrogen bonding with the amino acid 
ALA237, with a binding energy of -74.71 kcal/mol. 

Hence, the docking results confirmed that the 
compounds trans-anethole and p-cumin aldehyde bind to 
the active site of the beta-lactamase enzyme, leading to its 
inhibition. The compound p-cumin aldehyde forms two 
hydrogen bonds with the beta-lactamase enzyme in the 
active site, while trans-anethole forms one hydrogen bond 
with the beta-lactamase enzyme in the active site. Among 
these compounds, p-cumin aldehyde is the most effective 
inhibitor of the beta-lactamase enzyme (Figure 4).

Discussion
Antibiotic resistance is currently one of the major concerns 

Table 1. The Inhibition Zone of Discs Containing Plant Essential Oils

Bacteria Species Cuminum cyminum EO Inhibition Zone Foeniculum vulgare EO Inhibition Zone

Escherichia coli (ATCC 25922) 15 mm 16 mm 15 mm 14 mm 14 mm 13 mm

Listeria monocytogenes (IBRC-M 10671) 20 mm 21 mm 21 mm 19 mm 18 mm 19 mm

Control group 0 mm 0 mm 0 mm 0 mm 0 mm 0 mm

Note. The results of Tukey’s analysis of variance test showed that all four groups (cumin-Escherichia coli, cumin-Listeria monocytogenes, fennel-Escherichia coli, 
and fennel-Listeria monocytogenes) had significant differences with each other (P < 0.05). The highest inhibition zones belonged to the essential oil of cumin 
against Listeria monocytogenes, fennel against Listeria monocytogenes, cumin against Escherichia coli, and fennel against Escherichia coli, respectively.

Table 2. The Minimum Inhibitory Concentration of Essential Oils on Escherichia coli and Listeria monocytogenes

Species Essential Oils
1/10 
(v/v)

1/100 
(v/v)

1/200 
(v/v)

1/400 
(v/v)

1/600 
(v/v)

1/800 
(v/v)

1/1000 
(v/v)

1/1200 
(v/v)

1/1500 
(v/v)

1/2000 
(v/v)

Control

Escherichia coli 
(ATCC 25922)

Cuminum cyminum - - -  +  +  +  +  +  +  +  + 

Foeniculum vulgare -  +  +  +  +  +  +  +  +  +  + 

Listeria monocytogenes 
(IBRC-M 10671)

Cuminum cyminum - -  +  +  +  +  +  +  +  +  + 

Foeniculum vulgare - - - -  +  +  +  +  +  +  + 

Note. Inhibition: (-); Growth: ( + ).

Table 3. The Minimum Bactericidal Concentration of Essential Oils on Escherichia coli and Listeria monocytogenes

Species Essential Oils
1/10 
(v/v)

1/100 
(v/v)

1/200 
(v/v)

1/400 
(v/v)

1/600 
(v/v)

1/800 
(v/v)

1/1000 
(v/v)

1/1200 
(v/v)

1/1500 
(v/v)

1/2000 
(v/v)

Control

Escherichia coli 
(ATCC 25922)

Cuminum cyminum  +  +  +  +  +  +  +  +  +  +  + 

Foeniculum vulgare  +  +  +  +  +  +  +  +  +  +  + 

Listeria monocytogenes 
(IBRC-M 10671)

Cuminum cyminum -  +  +  +  +  +  +  +  +  +  + 

Foeniculum vulgare -  +  +  +  +  +  +  +  +  +  + 

Note. Colony inhibition: (-); Colony Growth: ( + ).
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among researchers, with significant risks to human health 
and the global economy. Consequently, various studies are 
being conducted to find new antibiotics from different 
sources. One group of compounds that has shown 
promising antimicrobial properties in various studies is 
plants’ EOs. These compounds are particularly important 

because they can also be used in food products (4,24,25). 
Given that E. coli and L. monocytogenes are significant 
causes of food poisoning, extensive research has been 
performed on the antibiotic resistance of these bacteria. 
Additional studies are also being implemented to discover 
new antibiotics, focusing on plant-based compounds that 

Table 4. Compounds in the Cuminum cyminum Essential oil Using Gas 
Chromatography-Mass Spectrometry

Compositions % Retention Time/min (RT)

α-Thujene 0.2 9.37

α-Pinene 0.6 9.49

Sabinene 1.3 9.76

β-Pinene 8.2 9.91

Myrcene 0.5 10.33

δ-2-carene 0.8 10.43

α-Terpinene 0.8 10.53

p-Cymene 15.8 10.59

Limonene 0.6 10.63

β-Phellandrene 0.1 10.84

1,8-Cineole 0.4 12.39

γ-Terpinene 13.4 12.50

Linalool 0.05 12.97

Terpineol 0.5 13.39

p-Cumin aldehyde 33.7 14.73

Perillaldehyde 0.8 14.87

Safranal 10.6 14.92

9-epi-β-caryophyllene 3.5 15.09

Germacrene D 0.2 15.26

E-α-Farnesene 0.5 15.30

Detected compounds 92.55 -

Table 5. Compounds in the Foeniculum vulgare Essential oil Using Gas 
Chromatography-Mass Spectrometry

Compositions %
Retention Time/

min (RT)

α-Pinene 0.6 7.38

β-Phellandrene 0.1 7.77

β-PINENE 0.08 7.83

α-Phellandrene 0.1 8.08

р-Cymene 0.2 8.56

D-limonene 9.5 8.90

Eucalyptol 0.06 9.35

Bicyclo[3.1.1]hept-2-ene, 3,6,6-trimethyl- 0.09 9.93

L-fenchone 13.20 10.04

Terpinene-4-ol 0.09 11.79

Estragole 7.2 12.60

Bicyclo[2.2.1]heptan-2-ol, 1,3,3-trimethyl-, 
acetate, (1S-exo)-

0.07 12.87

Trans –anethole 46.5 13.60

1-Butanone, 2-chloro-3-methyl-1 21.20 13.70

4-[(S)-sec-Butyl] anisole 0.1 14.87

4-Methoxyphenylacetone 0.07 15.03

m-Anisic acid, 4-chlorophenyl ester 0.1 16.30

Myristicin 0.1 17.36

Detected compounds 99.36 -

Figure 1. The Interaction Between P-Cumin Aldehyde and Listeria 
monocytogenes Beta-Lactamase

Figure 2. The Interaction Between Trans-anethole and Listeria monocytogenes 
Beta-Lactamase
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can be utilized in food products to limit the growth of the 
above-mentioned bacterial species (26-28).

In the present study, the antimicrobial properties of 
extracts from two plants, C. cyminum and F. vulgare, 
were examined both in vitro and in silico. The extracts 
of these two plants demonstrated antimicrobial activity 
against E. coli and L. monocytogenes. Furthermore, 
molecular docking studies showed the interactions and 
binding of the active compounds of these extracts with 
the beta-lactamase enzymes of the examined bacteria. The 
compound trans-anethole from fennel exhibited better 
binding to the active site of the beta-lactamase enzyme of 
L. monocytogenes, while p-cumin aldehyde from cumin 
represented better binding to a similar enzyme in E. coli.

Based on the disk diffusion test, it was determined 
that the diameter of the inhibition zone formed for L. 
monocytogenes was larger than that for E. coli. Furthermore, 
cumin exhibited a greater inhibitory effect (larger 
inhibition zone) against both bacteria compared to fennel. 
In the study performed by Barrahi et al, the antibacterial 
properties of the fennel extract were examined on Gram-
positive and Gram-negative bacteria, revealing that the 
inhibition zone diameter for Gram-positive bacteria was 
larger than that for Gram-negative species. Among Gram-
negative bacteria, the largest inhibition zone was observed 
for Klebsiella pneumoniae at 14 mm, whereas among 
Gram-positive bacteria, Acinetobacter baumannii showed 
the largest inhibition zone at 26 mm (20).

Numerous studies have explored the antibiotic 
properties of cumin and fennel. For instance, Barrahi et 
al examined the effects of the fennel extract on various 
Gram-positive and Gram-negative bacterial species. Their 
findings, which are in line with the present study’s GC/MS 
results, identified trans-anethole as the main compound 
in the fennel extract, though its concentration differed by 
2.1% (20). Additionally, Lemiasheuski et al investigated 
the impact of the fennel extract on opportunistic bacteria 
in human microflora. Despite the lack of the analysis of 
the ingredients using GC/MS, their findings demonstrated 
positive antibiotic activity (29).

Based on the GC/MS test, the main compound in 

cumin was identified as cumin aldehyde, comprising 
33.7% of the total compounds. Sharifi et al also used the 
cumin extract to evaluate its antibiotic properties against 
methicillin-resistant Staphylococcus aureus and found that 
the amount of p-cumin aldehyde in their studied cumin 
was 4.3% higher. Although Sharifi et al did not perform 
molecular docking tests, the reason for the antibiotic 
properties remained unidentified. In the present study, the 
results showed that p-cumin aldehyde and trans-anethole 
could form hydrogen bonds with the active site of the 
beta-lactamase enzymes of the studied bacteria (9).

Despite the various studies performed on each plant 
species, due to differences in the amounts of compounds 
in each plant under different environmental conditions 
and genetic variations, further research is still needed 
in this area (18,30). Zoubiri et al measured the amounts 
of different compounds in the fennel seed extract and 
compared these amounts with various studies, finding 
discrepancies in this regard. For example, the main 
compound of fennel in the present study was trans-
anethole at 46%, while in the studies reviewed by Zoubiri 
et al, this number ranged from 62% to 88% (18).

To the best of our knowledge, no in silico research 
has so far been conducted on the docking of active 
compounds from fennel (trans-anethole) and cumin 
(p-cumin aldehyde) onto the beta-lactamase enzyme of 
the studied bacteria. However, some studies indicated that 
certain active compounds isolated from plants possess the 
ability to bind to the beta-lactamase enzyme. For example, 
in a study by Ghodrati and Ataie Kachoie, it was found 
that compounds from the plant Hypericum perforatum 
exhibited inhibitory effects on the beta-lactamase enzyme 
of E. coli. Notably, when comparing the binding energy 
from their study to the present study, it is evident that 
the binding energy of p-cumin aldehyde was higher than 
that of the compounds isolated from H. perforatum (31). 
The results of the present study demonstrated that the 
binding energies of p-cumin aldehyde were -82.72 and 
-78.71 kcal/mol, while those of trans-anethole were -79.12 
and -74.71 kcal/mol for the beta-lactamase enzymes of L. 
monocytogenes and E. coli, respectively. These findings 

Figure 3. The Interaction Between P-Cumin Aldehyde and Escherichia coli 
Beta-Lactamase

Figure 4. The Interaction Between Trans-anethole and Escherichia coli Beta-
Lactamase
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indicate that p-cumin aldehyde exhibits the strongest 
binding affinity with the beta-lactamase enzyme of L. 
monocytogenes.

In this research, the researchers examined the 
antibiotic properties in the laboratory, identified the 
active ingredient, and then investigated the effects of 
these compounds on the beta-lactamase enzyme of the 
studied bacteria through molecular docking analysis. It 
should be noted that this study has limitations, such as 
the restriction to certain bacterial species; for instance, 
gram-positive bacteria ought to be examined more during 
studies working on antibiotics that affect bacterial species’ 
cell walls. Additionally, fungal species, particularly 
foodborne pathogens, could be evaluated as samples. 
Finally, further molecular docking tests could also be 
employed to evaluate the effects of these compounds on 
other parts and activities of bacterial cells.

Conclusion
Our findings demonstrated that the cumin EO exhibits 
potential antibacterial properties, particularly against 
L. monocytogenes and E. coli, as evidenced by its larger 
inhibition zones and lower MIC and MBC values 
compared to the fennel EO. The GC-MS analysis identified 
p-cumin aldehyde and trans-anethole as the major active 
compounds in cumin and fennel EOs, respectively. 
Moreover, molecular docking studies revealed that 
these compounds effectively bind to the beta-lactamase 
enzyme’s active site of both species, with p-cumin 
aldehyde showing superior inhibitory effects. Overall, 
these findings suggest that the cumin EO, particularly its 
active compound p-cumin aldehyde, may hold promise as 
a potent antibacterial agent.
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